
"Sync-it-yourself" Feature

The synchronization algorithm attempts to line up like text in the side-by-side File Viewer window.    
Its logic is based on finding a certain number of contiguous matching lines    At times the program 
lines up the wrong lines.
You can manually override the text synchronization by right-clicking the lines you would like to line 
up, selecting Link from the popup menu.    The two lines that you select are forced together, and 
following lines are re-synchronized.
In the following example, we would like to synchronize the "begin" lines.    First, right-click over the 
left pane and select Link:

Then do the same over the right pane:

The result:



You can use this feature several times to link up different parts of the files, as long as you work in a 
downward direction.    Each manual link causes a re-synchronization of the text below it, which will 
undo any manual links in that area.



Appearance Options (File Viewer)

You can change the colors that are used to highlight differences in text.    If you are using the 
program on a monochrome screen you should definitely change the colors so that mismatches show 
distinctly.    The sample viewer display lets you preview your selections.
Matching Text
Select the color for entire lines of text that match.
Similar Text
Select the color for similar text.    Similar text differs only in leading or trailing whitespace, or upper- 
lower-case mismatches.    A small sample viewer display is provided for you to preview appearance 
selections.
Different Text
Select the color for text that doesn't match.
Missing Text
Choose the style for indicating the "holes" in text comparison.    The Blank selection provides the 
cleanest looking display, but it makes it hard to distinguish blank lines from missing lines.    Choose 
Crosshatch to display diagonal lines across the missing section.    (Sorry, crosshatching does not 
work under Windows 3.1 or Windows NT.)    Or, choose a solid Color.
Horizontal Lines Between Mismatched Sections
Select this option to delineate matched vs mismatched sections of text with a horizontal line.    This 
helps to emphasize text differences, but if you typically have a lot of single line matches and 
mismatches it can make the display look cluttered.    The horizontal lines will always appear when the
Just Differences display option is selected.
Font
Click this button to select a font for the displayed text.    Use a monospaced font, such as Courier, for 
columnar text or files with tabs.



Appearance Options (Main Window)

You can change the colors that are used to highlight differences in the directory comparison.    If you 
are using Beyond Compare with a monochrome screen you should definitely change the colors so 
that mismatches show distinctly.
Matching Files
Select the color for files with matching directory entries.
Newer Files
Select the color for newer files.    This color is also used when the dates match but file sizes don't.
Older Files
Select the color for older files.
Files Older Than Cutoff
Select the color for files that are older than the cutoff date.
Single Side (Orphaned) Files
Select the color for files that exist in one directory but not the other.
Color Spots
Color Spots are small rectangles that hold their color when a line is highlighted, allowing you to 
clearly read highlighted text without losing the color cues.
Font
Click this button to select a font for the directory lists.



Backup Files Before Copy
When selected, this option instructs Beyond Compare to rename the file in the target directory before 
copying over it.    Backup files have a tilde (~) inserted in the extension.    For example, the backup of 
BEYOND16.EXE is BEYOND16.~EX.
Button Menu equivalent

File | Backup Files Before Copy



Collapse All
Close all subdirectories in the directory comparison.
Button Menu equivalent

View | Collapse All



Command Line Parameters

You can run Beyond Compare with command line parameters to speed access to your favorite 
directories.    You can specify:

a session name
a pair of directories, or
a pair of files.

If you specify an existing session name, that session will be loaded when Beyond Compare starts.    
For example:
BEYOND32.EXE "My Application <-> Floppy"
You can specify two directories on the command line:
BEYOND32.EXE C:\ALPHA C:\BETA
Note:    If you specify directories on the command line, the filename filter will be "*.*".
You can also specify two files on the command line and Beyond Compare will display them directly in
the File Viewer.
BEYOND32.EXE APPLES.TXT ORANGES.TXT

Using Windows 3.x
You can create multiple icons in Program Manager - one for each session you use often.    In 
Program Manager, select File | New and create a new Program Item.    In the Program Item 
Properties dialog box, enter an appropriate Description, fill in the Command Line as described 
above, and enter the path to BEYOND16.EXE in Working Directory.

Windows95 Shortcuts
To place a shortcut to a specific session on your desktop, start up the Windows Explorer, then locate 
the Beyond Compare program and drag it to a blank area of the desktop.    Then, right-click on the 
shortcut, select Properties from the popup menu, select the Shortcut tab and add edit the Target field
to include the session name.
Notice that if the path to the Beyond Compare program contains spaces, there will be quotation 
marks around the path.    Add the session name after the quotes.    For example:
"C:\Program Files\Beyond Compare\beyond32.exe" "My Application <-> Floppy"
Or, specify a pair of directories:
"C:\Program Files\Beyond Compare\beyond32.exe" C:\ALPHA C:\BETA
Or, specify a pair of files:
"C:\Program Files\Beyond Compare\beyond32.exe" C:\ALPHA\A.TXT C:\BETA\
B.TXT
If the directories or files that you specify contain spaces, be sure to enclose them in quotes:
"C:\My Application\A Long Filename.PAS"

Windows95 Command Prompt
Another option in Windows 95/NT4 is to run Beyond Compare from a DOS prompt, or from the Start |
Run command.    To save on typing, you might consider copying BEYOND32.EXE to your Windows 
directory, changing its name to something short like BC.EXE.    Then, you could type simply:
BC C:\ALPHA C:\BETA
Or,



BC About.pas Save\About.pas



Comparing .DFM Files

Borland Delphi's .DFM files are binary files, but Beyond Compare converts them to text for viewing 
and editing.    They are displayed side-by-side so you can identify form properties that have changed.



Comparing Directories

This is Beyond Compare's main window.    You may have more or fewer buttons on the toolbar 
depending on your current toolbar configuration.    Click on any area in the figure below for further 
explanation:

Colored text highlights changed files (based on file dates, sizes).    The small rectangular color spots 
hold their color when a line is highlighted, allowing you to clearly read highlighted text without losing 
the color cues.
If you have long filenames that are chopped off, drag the edge of the window for a wider display or 
select a smaller font.
The display filters limit the view to various match conditions.    Then you can select one or more lines 
in the list, and pick an operation to perform on them.    Operations are selected from the menu, 
toolbar buttons, or popup menu.
Simply double-click a line to open the file viewer for a side-by-side comparison of text files.    To 
compare files with different filenames (in the same or different directories), right-click on each 
filename, selecting Link from the pop-up menu.
See also:
Comparing Subdirectories
Printing a Directory Comparison Report
Plugin File Viewers
Setting Program Options



Comparing Files

This is the File Viewer window, highlighting the differences in text files side-by-side.    Click on any 
area in the figure below for further explanation:

Both panes scroll together, either vertically or horizontally.    In addition to using the scroll bars, you can 
scroll to the right by pressing Ctrl + Right Arrow or to the left with Ctrl + Left Arrow.
Use these features to peruse your files:

Next, Previous Difference
Just Differences
Find Text
Go To Line
You can produce a report of the differences between the files by selecting File | Differences Report.    
A dialog box appears, allowing you to send the report to your printer, a disk file, or the clipboard.
The File Viewer window is limited to comparing the first 32,500 lines of huge files.    This limitation 
does not apply to the Quick Compare function, which compares entire files.
WARNING:    You can view binary files if you like, but do not try to edit or save them!    If you do, they 
will be truncated at the first occurance of an end-of-file mark (Ctrl+Z), and may have CR/LFs 
inserted!

See also:
"Sync-it-yourself" Feature
Editing Files
Comparing .DFM Files.
Ignoring Leading, Trailing Columns
Setting Program Options



Comparing Subdirectories

If the Show Folders option is selected, all subdirectories will appear with folder icons in the main 
window (no matter which file filters or display filter are specified).
You can double-click on the folders to "open" them and view their contents, or "close" them:

File operations such as copy and delete do not work on subdirectories.    A folder needs to be "open" 
to perform operations on the files within it.    However, the Quick Compare function does work on 
"closed" folders, comparing their contents and recursing through any nested subdirectories.
You can open all folders with the Expand All function, or close them all with Collapse All.    
Additionally, you can right-click over a folder and select Expand Subfolders to open all folders within 
the selected folder.



Configuring the Toolbar

You can change the toolbar layout by right-clicking over it and selecting "Configure Toolbar" from the 
pop-up menu.    In this dialog box, drag buttons to or from the "currently on toolbar" list.    You can 
also rearrange the buttons by dragging them to different positions.



Beyond Compare

Beyond Compare is both a directory compare utility and a file compare utility wrapped in one.    It
was designed for use in managing programming projects, but it is useful for any time you need to 
compare the contents of directories.
Overview
Comparing Directories
Comparing Files
Editing Files
Managing Sessions
Command Line Parameters
Error Codes
Setting Program Options
License, Ordering Info
How To Contact Us

Copyright © 1996-97 Scooter Software
All rights reserved

Delphi is a Trademark of Borland International



Delete Files
This function deletes the selected files (after appropriate confirmation).    Since two files are selected at a 
time, separate confirmation dialogs are displayed for each file, positioned adjacent to the filename.    BE 
VERY CAREFUL with this function, particularly the "Yes to All" option.
Button Menu equivalent Keyboard shortcut

File | Delete Del



Differences Report
This feature produces a report of the differences between the files.    A dialog box appears, allowing you to
send the report to your printer, a disk file, or the clipboard.

Button Menu equivalent

File | Differences Report



This header area identifies the directories being compared.



This optional status bar provides information about the files displayed above.    You can disable by 
clearing the View | Statusbar option on the main menu.



Display Filters

In addition to file filters which limit comparison to types of files, you can filter the directory display 
based on how the directory entries match.
Show Any FilesShow Mismatched FilesShow Matching FilesShow Double SidesShow Mismatched Double SidesShow Single SidesShow Older FilesShow Newer Files
The Older Than Cutoff feature can further limit the display of files..



Editing Files

You can selectively reconcile differences between text files by copying or deleting lines.
In the Viewer window, select the lines you would like to edit, then right-click over the selection.    (To 
select an entire section of mismatched text, double-click over it.)    Pick a copy or delete operation 
from the popup menu:

Deleted text is changed to gray with a strike-through line.    Copied text is colored teal in the target file, 
and a small red arrow indicates the direction of the copy:

The status bar shows a reminder that a file has been modified.    You can cancel editing by selecting lines 
and picking Undo Edit from the popup menu.    Or, you can select Reload Files to revert to the stored 
version of the files.
Select Save to save your modifications.    If the File | Backup Before Save option is selected, Beyond 
Compare will keep a copy of the original file, adding a tilde "~" to the file extansion.
Or, you can select Save As to save the modified file under a different filename.



Error Codes

If you get an error message in Beyond Compare, hopefully it will be self-explanitory.    If not -- if you 
see a blunt message such as "I/O Error 3" or "Access Violation" -- it means we have failed to 
properly identify and handle a special condition.    Please let us know when this happens so we can 
improve the program.

Access Violation at xxxxxxxx
This is a serious failure in the program.    To make sense of the error address, we need to know the 
specific version of the program.

I/O Error Codes
These DOS error codes might help you understand or work around an error condition.
2 File not found
3 Path not found
4 Too many files open
5 Access denied
19 Disk write-protected
21 Drive not ready
23 Uncorrectable data error on disk
25 Seek error
28 Printer out of paper
29 Write fault
30 Read fault
31 General failure
32 Sharing violation
33 Lock violation
53 Network name not found
55 Device no longer exists on network
59 Unexpected network error



Expand All
Open all subdirectories in the directory comparison.
Button Menu equivalent

View | Expand All



Copy Files
These buttons control the copying of selected files from the left directory to the right, or vice versa.
A dialog box prompts you to confirm the copy operation.    If you attempt to copy an older file over a newer
one a larger warning box appears.
If the Backup Files Before Copy option is selected, Beyond Compare will rename the file in the target 
directory before copying over it.    It takes the original filename and inserts a tilde (~) in the extension.    
For example, BEYOND16.EXE would become BEYOND16.~EX.

Buttons Menu equivalents Keyboard shortcuts

File | Copy Right Ctrl+RightArrow

File | Copy Left Ctrl+LeftArrow



This header area identifies the files being compared.



File Operations

To perform the various file-related operations, select one or more files in the main window, then 
either:

· pick File from the main menu and select the desired function,
· click the appropriate toolbar button, or
· right-click over the files to bring up a popup menu of functions:

Link Files
Quick Compare
Copy Files
Backup Files Before Copy
Delete
Open With



File Viewer Menu

FileSearch View
Open With Next Difference Toolbar
Save Previous Difference Statusbar
Save As Go To Line Just Differences
Backup Before Save Find Scroll Right
Differences Report Find Again Scroll Left
Close Refresh

Options
File Viewer Options
Configure Toolbar

Help
Help Topics
About



File Viewer Options
This command calls up the options dialog for the file viewer.

Button Menu equivalent

View | Options | File Viewer Options



Find Text, Find Text Again
These buttons let you search for specific text in either file.

Buttons Menu equivalents Keyboard shortcuts

Search | Find Ctrl+F

Search | Find Again F3



General Options (File Viewer)

Find Next Difference
This option lets you modify the style of the "Find Next Difference" and "Find Previous Difference" 
commands.    The default setting is Position Only, which positions on the found difference without 
highlighing it.    This is so you can readily see the color coding that identifies the difference.    If you 
find that this makes it hard to notice the found line, you might try setting this option to Normal Line 
Selection instead.

Tab Stops
Set the number of columns per tab.



General Options (Main Window)

"Select Folder" Dialog on Startup
If this option is selected, the Select Folder dialog will automatically display on startup.    If you usually 
select a session from the recent sessions portion of the File menu, you will find it faster to deselect 
this option.
Show Hidden/System Files
Select this option to display and compare all files - including those that have the "hidden" or "system"
attribute set.
Show Folders
If this option is selected, you will see subdirectories in the directory compare window marked with a 
folder icon.    You can double-click the folder to "open" it and compare its contents.
Consider Timestamps Within 2 Seconds Equal
This option is useful for comparing directories between computers with different file systems.    For 
instance, the DOS FAT file system only stores file timestamps to the nearest 2 seconds, while NTFS 
and HPFS systems can represent timestamps to the nearest 100 nanoseconds.    Copying across a 
network, between file systems, can result in files with slightly different timestamps.    If this option is 
selected, those files would be treated as if they had the same times.    Deselect the option for slightly 
better performance.
Disable "Older Than" Cutoff Feature
Select this option to turn off support for the "Older Than Cutoff" feature.
Confirm File Copy
If this option is selected, Beyond Compare will prompt for confirmation before copying files.    Even if 
this option is not selected, the program will still warn if you are copying over a newer file.
Use Text-Based Quick Compare
This option modifies the behaviour of the Quick Compare function.    Instead of a straight binary 
comparison, a text-based compare assumes the files are text files and compares them line-by-line.    
Differences in line termination are ignored, so you can compare a DOS style text file with a Unix style
file.    The comparison stops on an end-of-file mark (Ctrl-Z).



Go To Line
This feature lets you go to a specific line number.    A dialog box will appear, allowing you to specify the 
line number and which side it applies to.

Button Menu equivalent Keyboard shortcut

Search | Go To Line Ctrl+G



How To Contact Us

Registered users are entitled to prompt e-mail support.    We are also happy to support unregistered 
users while they are evaluating the software.
Please send any comments, suggestions or bug reports to:

Tim Thousand
t1000@scootersoftware.com

Our mailing address is:
Scooter Software
2828 Marshall Court, #208
Madison, WI    53705-2276
USA

For the latest version of Beyond Compare and for other news about the program, visit our web site at
http://www.scootersoftware.com
If these addresses ever become obsolete, you should be able to find us by using the internet's Alta 
Vista service and searching for "Beyond Compare" or "Scooter Software".



Ignoring Leading, Trailing Columns

If your text files contain line numbers at the beginning or end of each line (such as COBOL source), 
you may want to ignore them for the purpose of comparing text.    You can specify the first and/or last 
significant column in Sync Algorithm Options.

The ignored columns are displayed in gray.



Just Differences
Select this option to display only the mismatched lines of text.

Button Menu equivalent

View | Just Differences



This optional legend bar identifies the current color scheme.    It can be enable or disabled by toggling 
View | Legend on the main menu.



License Agreement

You should carefully read the following terms and conditions before using Beyond Compare for 
Windows. Unless you have a different license agreement signed by Scooter Software, your use of 
this software indicates your acceptance of this license agreement and warranty. If you do not accept 
these terms you must cease using this software immediately.

Copyright
Beyond Compare for Windows ("the Software") is copyright © 1996-1997 by Scooter Software, all 
rights reserved.

Evaluation and Registration
This is not free software. You are hereby licensed to use the Software for evaluation purposes 
without charge for a period of 30 days. If you use the Software after the 30 day evaluation period a 
registration fee as described in the documentation is required. Unregistered use of the Software after
the 30-day evaluation period is in violation of U.S. and international copyright laws.
One registered copy of the Software may either be used by a single person who uses the software 
personally on one or more workstations, or installed on a single workstation used by multiple people, 
but not both.
An organization may purchase a multi-user license amounting to either the number of individuals 
who have access to the Software on any number of workstations, or the number of workstations that 
will access the Software by any number of individuals.

Distribution
Provided that you do not include your Registration ID Number (stored in the .INI file) you are hereby 
licensed to make copies of the Software; give exact copies of the original to anyone; and distribute 
the Software in its unmodified form via electronic means. You are specifically prohibited from 
charging for any such copies.

Governing Law
This agreement shall be governed by the laws of the State of Wisconsin.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED. NO WARRANTY OF FITNESS FOR A PARTICULAR 
PURPOSE IS OFFERED. ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO 
REFUND OF PURCHASE PRICE.



License, Ordering Info

The Beyond Compare program is distributed electronically, available from a variety of on-line 
locations.    In today's "connected" world, this is the fastest method of distribution and the easiest way
to provide you with program updates.    As such, there are no diskettes or printed manual (although 
the program has this extensive help file).
We will honor the prices mentioned here through February, 1998.    For current pricing information 
and the latest version of the program, visit our web site.

Step 1 - Evaluate the Program
You can use the program free for 30 days to see if it suits your needs.    If you use it beyond 30 days 
you are obliged to pay the license fee.    Please read the License Agreement for details.    If you do 
not register the program, it will stop functioning 45 days after it was first run.    If you need more time 
for evaluation, please e-mail us for an extension.

Step 2 - Register
You "register" the program by paying the license fee.    Once we receive your registration we send 
you a registration ID (by e-mail) that you enter into the program.
The single user license fee for the full program is US$30.    You can double the number of licensed 
users within an organization for each additional $20.    See our pricing table.
Registering by mail
Registering on-line through CompuServe
Registering on-line through the Internet
Registering by phone or by fax
Whatever method you use to register, we will need your name, organization (if any) and e-mail 
address in order to provide your registration ID.    We will never use your e-mail address for other 
purposes.    (If you cannot provide an e-mail address, be sure to include your mailing address so we 
can mail your registration ID.)

Step 3 - Unlock the Program
Once we receive your registration, we will e-mail you back with your registration ID, usually within 12 
hours.    If you register on-line or by phone and do not hear from us within 24 hours, please send us a
message.
When you receive your registration ID, choose Register from the "Thank you for trying Beyond 
Compare" screen (or, select Help | Register from the main menu).    Enter the registration data 
exactly as shown, since the registration ID is keyed to this information.
The registration ID disables the "nag" screen, removes the 45 day timeout, and unlocks certain 
features of the program.    Registered users may also have access to bonus plugins from a special 
"members only" web page.
Your registration ID will work with both BEYOND16 and BEYOND32, as well as all subsequent minor
version updates (eg. 1.6, 1.7).



Link Files
This function lets you compare two files with different names.    Right-click over the first file and select Link
from the popup menu.    Then do the same for the second file.    The files can be in the same directory or 
different directories.



Main Window Menu

File Edit Display Filter View
      Open       Select All       Show Any Files       Toolbar
      Open With       Select Newer       Show Mismatched Files       Statusbar
      Link       Show Matching Files       Legend
      Quick Compare       Show Double Sides       Expand All
      Copy Right ->       Show Mismatched Double Sides       Collapse All
      <- Copy Left       Show Single Sides       Refresh
      Delete       Show Left Side Older Files       Options
      Backup Files Before Copy       Show Left Side Newer Files Main Window 
Options
      Folders       Set Cutoff Configure 
Toolbar
      Print File Viewer 
Options
      Exit
      recent sessions

Help
      Help Topics
      Register
      About



Main Window Options
This command opens the options dialog for the main window.    Use it to customize the appearance and 
functionality of directory comparisons.
Button Menu equivalent

View | Options | Main Window Options



Managing Sessions

A unique feature of Beyond Compare is its use of named "sessions" to remember where your 
different projects are located and what types of files you want to synchronize.    Sessions are stored 
in the BEYOND32.INI (or BEYOND16.INI) file located in your Windows directory.
For example, the "My Application <-> Floppy" session could identify C:\DELPHI\MYAPP as the left-
hand directory; A:\ as the right-hand directory; and *.pas, *.dfm, *.dpr, *.bmp as the file filters.    You 
can leave out other files such as *.dcu, *.dsm and *.dsk which you probably don't want to copy to a 
different Delphi installation.
Alternatively, you can include all files (*.*) and then specify files to skip.    Use a hyphen in front of a 
file filter to exclude that class of files.    For instance, the filter -*.~?? will suppress the display of the 
"backup" files that Beyond Compare creates.    Exclusion filters should come after filters that include 
the files that you want to exclude.    Clear?
The <untitled> session refers to the last time you used Beyond Compare without using or saving a 
named session.

Creating a New Session
In the Select Base Folders dialog, once you've specified the directories and filters, click "Save As" 
and enter a descriptive name.

Returning to a Session
Select File from the menu and pick from the 9 most recently used sessions, or pick any session from 
the drop-down list in the Select Directories dialog.
If you typically pick a session from the File menu you may want to disable the Select Folder Dialog 
on Startup option.    See General Options.
Speed Tip:    You can create an icon to run Beyond Compare with a particular session name on the 
command line.

Modifying a Session
To change an existing session, select it from the drop-down "Session" list in the Select Base Folders 
dialog, make the desired changes to the drives, directories or filters, and click "Save As".
To delete a session, select it and click "Remove".



Matching directory entries are shown in black by default.



Lines that are identical are displayed in black by default.



Mismatched lines are displayed in color.    One color is used for "similar" text and another is used for 
different text.
"Similar" text is defined as differing only in leading or trailing whitespace, or upper vs lower case.    Lines 
are scanned from their ends towards the middle until different (non-similar) text is found.



This section represents missing text - perhaps lines that were deleted from this file or lines that were 
inserted in the opposite file.    Missing text can be indicated in different ways.    See File Viewer 
Appearance.



Files with newer date stamps are shown in red by default.    Also, files with matching date stamps but 
differing sizes are shown in red in both directories.



Next Difference, Previous Difference
These buttons jump to the next or previous section of mismatched text.

Buttons Menu equivalents Keyboard shortcuts

Search | Next Difference Ctrl+N

Search | Previous Difference Ctrl+P



Older files are shown in gray by default.



Older Than Cutoff

This feature allows you to ignore files older than a specified cutoff date.    From the main menu select
Display Filter | Set Cutoff and enter a date, or a date and time.    If you have the legend bar enabled, 
the cutoff date/time will appear on it as a reminder.    You can easily set the cutoff date to match a file 
or directory date by right-clicking over the appropriate entry and selecting Acquire Cutoff from the 
popup menu.
Files will not appear in the directory comparison unless at least one of the pair is newer than the 
cutoff.    Therefore, if files (matched or mismatched) are both older than the cutoff, they do not 
appear.    If a file is on one side but not the other (orphaned) and is older than the cutoff, it will not 
appear.    These rules are followed regardless of the Display Filter selection in effect.
Files older that the cutoff will only appear if there is a newer (than cutoff) version in the other 
directory.    The older file will appear in a different color, which you can pick in the Appearance 
Options.
The oldest cutoff date you can specify is January 1, 1980.    You can disable the "older than cutoff" 
feature entirely in General Options.



Open With

The Open With feature allows you to open files with other applications, such as your favorite text 
editor.    Right-click over a file in the Main Window, select Open With and the appropriate application, 
and that application will be run on the file selected.    Although both side-by-side files may be 
highlighted, Beyond Compare is sensitive to which one was clicked over.
You can also right-click over a file in the File Viewer window and select Open With from the popup 
menu.    And, if your editor supports it, you can have the editor jump to the same line as selected in 
the File Viewer (see Replaceable Parameters below).
The Open With feature is only available in the registered program.

Setup "Open With" Options
From the Main Window menu, select View | Options, and then select the Open With tab.    In the 
memo field, enter the applications you would like access to in the following format:

Notepad=notepad.exe
Wordpad=write.exe
Hex Editor=C:\Program Files\HexEdit\HexEdit.exe

You do not need to specify the folder if the program is in the Windows folder.    Note that the 
WordPad program file is called write.exe.

Replaceable Parameters
By default, Beyond Compare simply adds the current filename at the end of the line before carrying 
out the operation.    For more control, you can use %f to represent the filename and %l (lower case 
"L") to represent the current line number.
For example, suppose you are comparing two versions of the file "mouse.txt" and you wish to use 
your "Cat" editor to edit the left file.    You are positioned on line 75 in the left file.
"Open With" definition Resultant operation
Cat=c:\util\cat.exe c:\util\cat.exe mouse.txt
Cat=c:\util\cat.exe %f/L=%l c:\util\cat.exe mouse.txt/L=75
Cat=c:\util\cat.exe "%f" -#%l -s3 c:\util\cat.exe "mouse.txt" -#75 -s3
Consult your editor's documentation for the proper command line syntax.    You may find putting 
quotes around the filename parameter useful when dealing with long filenames.



You can configure Beyond Compare to open files with your favorite utilities.
(registered program only)



Beyond Compare Order Form 1.5

From: ____________________________________________ Date: ______________
____________________________________________
____________________________________________
____________________________________________

Please indicate how you would like your registration information to display (in the Beyond Compare 
"about" box).    For multi-user licenses we prefer to include a reference to the user count, such as: 
"ACME Corporation - 8 users".

User Name: __________________________________________

Organization: __________________________________________

Specify an e-mail address for us to use to send your registration ID # and for program update 
notices:

email: __________________________________________

Qty Description Unit Price Total

____ Beyond Compare for Windows $30 ________

____ License Doubler* $20 ________

____ Other ____________________________ _______ ________

5.5% tax (Wisconsin residents only) ________

Total ________

* Each "License Doubler" doubles the number of registered users.    For example, 1 Beyond 
Compare license + 3 License Doublers = 8 users = $90.

Make check (US funds only) payable to Scooter Software and mail it with this form to:
Scooter Software
2828 Marshall Court, #208
Madison, WI    53705-2276

For other payment options, visit our web site at www.scootersoftware.com or contact Tim Thousand at 
t1000@scootersoftware.com



Overview

Have you ever struggled with synchronizing source files between directories?    Hard disk and 
floppy?    Keeping track of changes you made at home verses at work?
There are many tools that will blindly synchronize directories based on modification date, but 
sometimes it's the older file that you need to keep.    Or just two lines of code in the older file that you 
need.    Also, have you noticed that Delphi sometimes modifies .DPR and .DFM files without 
changing their date stamps at all?
We have projects where we share source with outside programmers, and we tinker with certain 
components at home.    We needed a tool that speeds the distribution of source files, but also lets us 
carefully analyze changes to code.    So we wrote this one...

Directory Compare Features:
Side-by-side comparison of two directories sorted by filename
Multiple filename/extension filters
Saves your favorite project "sessions" for fast repositioning
Color highlighting of newer files, mismatched files
Copy, delete functions
Fast binary compare of files - are they really the same?
Side-by-side comparison of two directory trees
Recursive binary comparison of directory trees

File Compare Features:
Side by side comparison of two text files
Color highlighting of mismatched, inserted lines
Copy lines of text from one file to the other - delete lines
"Sync-it-yourself" manual synchronization override
Displays Delphi .DFM files as text - identifying changes to forms
Handles very long lines



Plugins

Plugins are add-on products that enhance and extend Beyond Compare's functionality.    Typically 
they offer the ability to display non-text files side-by-side.    For instance, we intend to offer a hex 
viewer plugin that displays binary files side-by-side in hexadecimal notation.
We also have a Plugin Toolkit product that helps Delphi programmers produce custom plugins for 
Beyond Compare.
Support for plugins is only available when the program is registered.    See our web site for a list of 
available plugins.

Installing Plugins
A plugin is provided as a .DLL file which should be copied to the same directory as the Beyond 
Compare program.
After copying the plugin file, start Beyond Compare and from the main window menu, select View | 
Options.
Under the Plugins tab, click the "Install New Plugin" button and enter the name of the plugin (the 
filename without the extension).
Next, specify the file extensions you would like the plugin to process.    If more than one, separate 
with spaces.    An asterisk ('*') refers to "all extensions".    When viewing files, Beyond Compare will 
search down the Installed Plugins list and use the first one that matches the file extension being 
processed.    You can change the order in this list by dragging the plugin names to different positions.
The built-in file viewer appears as "<default>".    You can't remove it but you can change which file 
extensions it handles, and you can change its order in the list.



Right-click over a line in order to manually override the text synchronization.



Standard Pricing Table
Number of Users             Total Amount  

1 $30
2 $50
4 $70
8 $90
16 $110
32 $130
64 $150
128 $170
256 $190
512 $210
etc.



Printing a Directory Comparison Report

To get a printed report of the current directory comparison you can either:
· select File | Print from the main menu, or
· click the Report button on the toolbar (you can add this button if it's not already there)

The report that is produced mimics the layout of the main window.    The display filter buttons control 
both the main window and the report contents.



Quick Compare
This function does a binary comparison of the selected files.    The files can be of any type.    A message 
informs you whether all files match or which files don't.
Button Menu equivalent

File | Quick Compare



Refresh
Click this button to refresh the directory display.    This will reflect any changes made by other applications
or other network users.
Button Menu equivalent Keyboard shortcut

View | Refresh F5



Registering Through CompuServe

If you have access to CompuServe, you can conveniently register Beyond Compare though their 
Shareware Registration service (SWREG).    GO SWREG and follow the instructions, searching for 
ID #13019.    The $30 fee will be added to your CompuServe bill.
If you would like to register a multi-user license though CompuServe, please note that their "quantity"
field will refer to the number of $30 increments rather than the number of registered users.    The 
table below reflects our standard pricing table adapted for even multiples of $30.
Number of Users Total Amount SWREG "Quantity"

1 $30 1
3 $60 2
8 $90 3
24 $120 4
64 $150 5
192 $180 6
512 $210 7

If you would like us to respond to an e-mail address other than your CompuServe address, you can 
include it with the mailing address information that you fill out in SWREG.



Registering Through the Internet

To register on-line through the Internet using a major credit card, visit RegNet, the Registration 
Network, at www.swregnet.com and look for Beyond Compare under one of these Index numbers:
Number of Users Total Amount RegNet Index #

1 $30 #811
2 $50 #1023
4 $70 #1024
8 $90 #1025
16 $110 #1310

Please note that RegNet cannot answer technical questions about Beyond Compare.    Contact 
Scooter Software for support.



Registering by Mail

You can register Beyond Compare by mail by printing this order form and sending it with a check 
drawn on a US bank to:

Scooter Software
2828 Marshall Court, #208
Madison, WI    53705-2276
USA



Registering by Phone

You can register Beyond Compare by phone or by fax through RegNet, the Registration Network.    
Their numbers are:

1-800-999-2734 toll free within the US
1-805-288-1827accessible outside of US
1-805-288-1867 fax orders

Specify one of these Index numbers:
Number of Users Total Amount RegNet Index #

1 $30 #811
2 $50 #1023
4 $70 #1024
8 $90 #1025
16 $110 #1310

Please note that RegNet cannot answer technical questions about Beyond Compare.    Contact 
Scooter Software for support.



Reload Files
This feature reloads both files.    Use it to display any changes made to the files (by other applications) 
since the File Viewer was invoked.    You will lose any "sync-it-yourself" alignments or editing 
modifications you may have made.

Button Menu equivalent Keyboard shortcut

View | Refresh F5



Report
This feature produces a report that mimics the current directory comparison.

Button Menu equivalent

File | Print



Save As
Select this command to save modifications under a new file name.    If both files were modified, you will 
get a separate Save As dialog for each file.

Button Menu equivalent
(none) File | Save As



Save Changes
Select this command to save modifications to either or both files.    You will get a separate confirmation 
dialog for each file.

Button Menu equivalent Keyboard shortcut

File | Save Ctrl+S



Scroll Right, Scroll Left
These buttons scroll the file display to the right or left.    Both panes of the viewer scroll in tandem.

Buttons Menu equivalents Keyboard shortcuts

View | Scroll Right Ctrl+RightArrow

View | Scroll Left Ctrl+LeftArrow



Select All
Click this button to select all the displayed files.
Button Menu equivalent Keyboard shortcut

Edit | Select All Ctrl+A



Select Base Folders

To open the Select Base Folders dialog, you can either:
· select File | Folders from the main menu, or
· click the Select Base Folders tool button

Speed Tip: You can bypass this dialog by selecting a recently used session from the File menu.

Session
This drop-down combo box allows you to either select an existing session, or to enter a new session 
name.    Click the Save button to save the current settings under this name.    Click Remove to delete 
this session.    See also Managing Sessions.

Drives and Directories
Use the drive and directory controls to select the "left" and "right" folders for comparison.    The order 
isn't important - either can be used as source or target in file operations.

Filters
Specify the types of files you want to compare in this free-format memo field.    Enter one file 
specification per line.
Use a hyphen in front of a file specification to exclude that class of files.    For instance, the filter -
*.~?? will suppress the display of the "backup" files that Beyond Compare creates.    The filters are 
applied in order, so exclusion filters should come after other filters.



Select Base Folders
This command opens the Select Folders dialog.    Use it to set or change the base directories to compare,
or the file filters to use.

Button Menu equivalent

File | Folders



Select Newer
Click this button to select the files in the left pane that are newer than those in the right pane.    Click it 
again to select newer files in the right pane.
Button Menu equivalent

Edit | Select Newer



Selected files are highlighted in the normal manner.    You can click and drag to select several adjacent 
lines, or you can hold the Ctrl key down while you click specific lines.

Select one or more lines before picking an operation to perform on them.



Setting Program Options

There are several ways that you can customize the behavior of the program.    Beyond Compare's 
optional features are split between those relating to the Main Window (directory comparison) and the 
File Viewer window.
The resultant configuration is stored in the BEYOND32.INI (or BEYOND16.INI) file in your Windows 
directory.
If you are upgrading from BEYOND16 to BEYOND32 and would like to keep your sessions and other
settings, you can copy BEYOND16.INI to BEYOND32.INI.

Main Window Options
Select View | Options from the menu in the Main Window to set these options:
General Options
Appearance Options
Plugins
Open With

File Viewer Options
Select View | Options from the File Viewer menu to set these options:
General Options
Appearance Options
Sync Algorithm Options

Toolbar Options
You can display or hide either window's toolbar by selecting or deselecting the Toolbar option in 
either window's View menu.    To add, remove or rearrange the buttons on the toolbar, right-click over 
the toolbar and select Configure Toolbar.

Legend
You can display or hide the legend at the bottom of the main window by changing the View | Legend 
option in the main menu.

Statusbar
You can display or hide the status bar at the bottom of each window by selecting or deselecting the 
Statusbar option in the View menu.



Show Any
Display any file in the directories (as long as it conforms to the current filters)

Button Menu equivalent

Display Filter | Show Any Matches



Show Double Sides Only
Display files that are on both sides of the directory conparison.
Button Menu equivalent

Display Filter | Show Double Sides



Show Matches Only
Display files with matching directory entries.    Note that their contents are not necessarily identical.
Button Menu equivalent

Display Filter | Show Matching Files



Show Mismatched Double Sides Only
Display files that are on both sides of the directory comparison and have mismatched directory entries.
Button Menu equivalent

Display Filter | Show Mismatched Double Sides



Show Mismatches Only
Display only those files whose directory entries differ.    Note that their contents are not necessarily 
different.

Button Menu equivalent

Display Filter | Show Mismatched Files



Show Newer
Display files that are both directories but are newer in the left directory.
Button Menu equivalent

Display Filter | Show Left Side Newer Files



Show Older
Display files that are both directories but are older in the left directory.
Button Menu equivalent

Display Filter | Show Left Side Older Files



Show Single Sides Only
Display files that are on one side of the directory comparison but not the other.    Useful for isolating 
missing or obsolete files.
Button Menu equivalent

Display Filter | Show Single Sides



"Single Side" or "orphaned" files are in one directory but not the other.    They are shown in blue by 
default.



The optional Status Bar displays line numbers, file status (readonly or modified), and a scroll bar that 
scrolls left and right views simultaneously.    You can disable it by clearing the View | Statusbar option on 
the main menu.



Sync Algorithm Options

Minimum Lines in Match
This represents the minimum number of lines that need to match before Beyond Compare will 
synchronize text.    Enter a number between 1 and 50 (the default is 5).    A larger value helps prevent
syncing on trivial matches, such as blank lines, or "begin" and "end" statements in Pascal.    A "Hot 
Match" (see below) overrides this rule.
Skew Tolerance
Skew tolerance is the number of lines Beyond Compare will search forward or backward in a file, 
looking for a matching sequence.    You can normally keep this value rather high (the default is 9999) 
when working with small to moderately large text files.    However, comparing huge files with long 
sections of mismatched text can be quite slow.    Use a smaller number for higher performance, 
especially if large insertions or deletions of text are not likely.
Enable "Hot Match" Feature
The Hot Match feature gives synchronization preference to important lines.    Currently, only certain 
Pascal keywords are recognized:    "procedure", "function", "constructor" and "destructor".    Lines that
match and contain one of these words override the "minimum lines in match" rule.
Treat "Similar" Text as Exact Match
Leading and trailing whitespace is defined as any spaces or tabs found at the beginning or end of 
lines.    Similar text differs only in leading or trailing whitespace, or upper- lower-case mismatches.
If this option is not selected, lines with differences only in whitespace and character case are 
considered "similar".    They will be synchronized, but they appear in the Similar Text color and they 
count as mismatches for the Display Just Differences, Find Next Difference and Find Previous 
Difference operations.
If this option is selected, differences in leading/trailing whitespace and character case are ignored 
altogether.
Starting Column for Compare
Enter the first significant column for text comparison.    This is useful if your text files contain line 
numbers (such as COBOL source) and you don't want them to affect the text comparison.    The 
columns are displayed in gray to remind you that they are being ignored.
Ending Column for Compare
Enter the last significant column for text comparison.    Beyond Compare will ignore any text to the 
right of this column for comparison purposes.    The ignored text is colored gray.    Leave this field 
zero to disable the feature.
Reset Defaults
Click this button to revert sync settings back to default values.



You can customize your toolbar, adding or removing buttons as you like.    Right-click anywhere over the 
toolbar to access the toolbar configuration.    Disable the toolbar altogether by clearing the View | Toolbar 
option.



We will only use your e-mail address to send your registration ID and, unless you request otherwise, 
notifications of program updates.




